NOTICE

The information contained in this document is believed to be accurate in all respects but is not warranted by Mitel Communications, Inc. (MITEL®). The information is subject to change without notice and should not be construed in any way as a commitment by Mitel or any of its affiliates or subsidiaries. Mitel and its affiliates and subsidiaries assume no responsibility for any errors or omissions in this document. Revisions of this document or new editions of it may be issued to incorporate such changes.

No part of this document can be reproduced or transmitted in any form or by any means - electronic or mechanical - for any purpose without written permission from Mitel Communications, Inc.

TRADEMARKS

Clearspan® and Mitel® are trademarks of Mitel Networks Corporation.

Other product names mentioned in this document may be trademarks of their respective companies and are hereby acknowledged.
# Table of Contents

1 REVISION HISTORY ........................................................................................................... 1

2 ABOUT CLEARSPAN COMMUNICATOR FOR DESKTOP .............................................. 2

3 GETTING STARTED ........................................................................................................... 3
   3.1 Installation .................................................................................................................. 3
   3.2 Sign In ....................................................................................................................... 3
   3.3 Main Window ............................................................................................................ 4
   3.4 Communications Window ....................................................................................... 5
   3.5 Start Chat ................................................................................................................ 6
   3.6 Make Audio or Video Call ....................................................................................... 6
   3.7 Share Your Desktop ................................................................................................. 7
   3.8 Active Communications ......................................................................................... 7
   3.9 My Room ................................................................................................................ 8
   3.10 Select Audio Devices ............................................................................................ 8

4 CONTACTS ..................................................................................................................... 10
   4.1 Add .......................................................................................................................... 10
   4.2 Edit .......................................................................................................................... 10
   4.3 Filters ...................................................................................................................... 11

5 PRESENCE ..................................................................................................................... 12

6 CHAT ............................................................................................................................. 14
   6.1 Chat View ................................................................................................................. 14
   6.2 File Transfer ............................................................................................................ 14
   6.3 Group Chat ............................................................................................................. 15
   6.4 Chat Recording ....................................................................................................... 15

7 AUDIO AND VIDEO CALLS .......................................................................................... 16
   7.1 Call From Your Computer ..................................................................................... 17
   7.2 Call From Phone ..................................................................................................... 17
   7.3 Answer Call ............................................................................................................. 17
1 REVISION HISTORY

Clearspan Communicator for Desktop is a native Windows and Mac client for Unified Communications, providing the following communication features:

<table>
<thead>
<tr>
<th>REVISION NUMBER</th>
<th>DATE COMPLETED</th>
<th>POINT OF CONTACT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>2807-001</td>
<td>11/17/2008</td>
<td>Danielle Woelfle</td>
<td>Initial release of this publication.</td>
</tr>
</tbody>
</table>
2 ABOUT CLEARSPAN COMMUNICATOR FOR DESKTOP

Clearspan Communicator for Desktop is a native Windows and Mac client for Unified Communications, providing the following communication features:

- Instant Messaging and Presence (optional Clearspan features)
- Voice Calling (VoIP)
- Voice Calling (Desk phone)
- Video Calling
- Desktop Sharing (optional Clearspan feature)
- Clearspan Call Settings

This document covers the three versions of Clearspan Communicator for the Desktop: Audio, Video, and Lite. The Lite version allows you to place and receive calls through your desk phone using the desktop client. The Audio version of the client adds the ability to connect audio calls through the desktop interface, and the Video version adds the ability to have video calls.
3 GETTING STARTED

This section contains the essential information for getting started with Clearspan Communicator.

3.1 INSTALLATION

Your service provider provides the download of the installer.

Windows
- Double-click the installer executable and follow the installation instructions.
- Launch Clearspan Communicator.

OS X
- Double-click the disk image.
- Copy the application into the Applications folder.
- Launch Clearspan Communicator.

3.2 SIGN IN

When you first launch the application, you are prompted to sign in.

1. If displayed, enter the login Uniform Resource Locator (URL) provided by the service provider.
2. Enter your Clearspan user name and password.
3. Select whether you would like Clearspan Communicator to remember your password.
4. Select whether you would like Clearspan Communicator to sign you in automatically on subsequent launches.
5. Click Sign In.

Note: If you choose automatic sign in, you are automatically signed in and taken to the contact list upon subsequent Clearspan Communicator launches. Otherwise, you are presented with the Sign In screen.

After logging in, a popup dialog may appear informing you about emergency calls. You may also see a banner in the Main window related to emergency calls. Depending on your service provider settings, emergency calls may not be allowed. In this case, calling an emergency number displays a popup dialog. A notification message in the Main window may also display.
3.3 MAIN WINDOW

When you start Clearspan Communicator for the first time, your Contacts list is empty. Use the search field to find people and add them to your Contacts list. Contacts can also be added manually by clicking the Add (+) button. Client windows can also be set to be always using the main window menu option. Note also, that depending on your service provider settings, the order of the left pane icons may vary. The left pane call settings icon and menus are visible depending on your service provider settings. The dial pad is also integrated with the Main window.
My Information

- Click the avatar to update your status or location (if configurable) and enter free text.
- Double-click the avatar to upload a picture or use a right-click menu.
- Right-click the avatar to update your status.

Presence

You can set your presence to one status indicated in the following table.

<table>
<thead>
<tr>
<th>ICON</th>
<th>WHAT IT MEANS</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟢</td>
<td>Available. The green presence icon indicates that the user is online and ready for communication.</td>
</tr>
<tr>
<td>🟠</td>
<td>Away. The yellow presence icon indicates that the user is online but has been idle or away from their computer for more than ten minutes.</td>
</tr>
<tr>
<td>⚡</td>
<td>Busy. The red presence icon indicates that the user is busy and does not want to be disturbed.</td>
</tr>
<tr>
<td>🔴</td>
<td>Offline. The grey presence icon indicates that the user is offline and the only available contact method is calling or chatting.</td>
</tr>
<tr>
<td>📞</td>
<td>This icon indicates that the contact is busy on a call. This is an automated presence status.</td>
</tr>
<tr>
<td>📷</td>
<td>This icon indicates that the contact is busy in a meeting. This is an automated presence status. The Busy – In Call status overrides the Busy – In Meeting status so this one is only seen if there is a meeting but no call.</td>
</tr>
</tbody>
</table>

You can set your Presence to Available, Away, Busy, and Offline. Clearspan Communicator can automatically update your presence to Busy, In a Call and Busy, In Meeting (Windows only).

Location

Your location is automatically determined by your public IP address; however, if your system administrator has enabled it, you can manually set the text to appear for your location and time zone using the location dialog box.

3.4 COMMUNICATIONS WINDOW

After starting communication with one or more contacts, a Communications window is displayed for chat and may be displayed for calls depending on your service provider settings. The call window can also be integrated with the Main window. From this window, you can perform the following actions:

- Escalate a chat to include audio, video, and desktop sharing
- End an audio or video call
- Open the dial pad
- Mute your microphone
- Adjust your speaker volume
- Place a call on hold
- Transfer a call

3.5 START CHAT

Start a chat using one of the following methods:

- Double-click a contact from the Contacts list or search results.
- Left-click one or more contacts from the Contacts list or search results and click Chat.
- Right-click one or more contacts from the Contacts list or search results and click Chat.
- On the Communications History list, double-click a chat entry.
- In a Communications window, click the Chat button.
- In a one-to-one chat, transfer files by clicking the Send File button in the Communications window or use the drag-and-drop method so that they are moved to the Communications window.

3.6 MAKE AUDIO OR VIDEO CALL

Make an audio or video call using one of the following methods:

- Left-click one or more contacts from the Contacts list or search results and click the Call, Call from Phone, or Video button.
- Right-click one or more contacts from the Contacts list or search results and click the Call, Call from Phone, or Video.
- Enter a phone number in the Search and Dial field.
  - Press ENTER to start a VoIP call.
  - Click the Call, Call from Phone, or Video button.
- Open the dial pad, enter a phone number, and then click the Call, Call from Phone, or Video button.
- On the Communications History list, double-click a call entry.
- In the Communications window, click the Call, Call from Phone, or Video button.
- When viewing a contact’s profile, click the Call, Call from Phone, or Video button.

Note: If dialing a phone number that requires additional dual-tone multi-frequency (DTMF) tones (for example, a conference bridge), you can type the numbers on your keyboard while the Communications window has focus or open the dial pad in the Communications window.
3.7 SHARE YOUR DESKTOP

Share your desktop by following these steps:

1. Click the **Share Desktop** button.
2. Click the **Start** button after the share preparation has completed.

**Note:** To share your desktop, you must enter your web collaboration credentials in Preferences → Credentials, unless your service provider has automated provisioning in use. For more information, see 13 Preferences. You can participate in desktop sharing sessions by another user even without having your own sharing credentials.

3.8 ACTIVE COMMUNICATIONS

Active communications appear at the top of the Contacts list in the main window. This area provides an easy view to see the people with whom you are communicating. By default the call window is shown in the Active Communications area in the Main window (where the call can be fully controlled in the desktop client). It reduces the number of communications windows; however, a separate call window can still be opened using an Active Communications menu. The following is also available in this area:

- Double-click an active communication to bring this Communications window to focus if the call window is separately shown. If the call window is integrated, you can use a menu option to show it separately.
- See who has sent you a chat message, but only after you accept the chat session. Before the chat session is established, the chat items are not visible in active communications but a history badge is visible.
- End a call.
- Mute the microphone.
- Place a call on hold.
- Merge two calls or transfer by dragging and dropping calls onto each other.
- Transfer a call.
- Make conference calls.
- See call recordings.
- Park and retrieve calls.

As a service provider option in Release 20.2.2 and onwards, more buttons can be added to the active communications area:

- Conference
- Call transfer
- Call park

When enabled, you can use the buttons for faster access to the services.
3.9 MY ROOM

*My Room* is an always available and permanent room you can use to chat with anyone that joins.

If you assign a conference bridge to your profile in *Preferences → Credentials*, then in your room, you and your attendees can click the **Call** or **Video** button to have Clearspan Communicator automatically dial in to the conference and enter the appropriate entry codes. Note, if your service provider has auto-provisioning enabled, then you cannot edit these details. If your service provider has silent dialing enabled, then you cannot hear any DTMF tones when dialing into My Room (the call is made directly).

If a conference bridge is not specified, you can initiate an N-way call in your room. Clearspan Communicator dials out to all participants and takes everyone off hold after the last attendee answers.

You can invite others to your room by dragging and dropping them from the *Contacts* list into the *My Room Communications* window.

Others join your room by right-clicking your name on their *Contacts* list and selecting **Join Room**.

My Room and Desktop Sharing are optional Clearspan features.

3.10 SELECT AUDIO DEVICES

If you have multiple audio devices available for your microphone or speakers, select the preferred audio device before starting a call.

**Windows**

1. Click the Clearspan Communicator logo in the main window title bar.
2. Select **Preferences**.
3. Select **Audio**.
4. Set a playback device (speakers).
5. Set a recording device (microphone).
6. Click **OK**.

**OS X**

1. Select Clearspan Communicator from the main menu.
2. Select **Preferences**.
3. Select **Audio**.
4. Set a playback device (speakers).
5. Set a recording device (microphone).
6. Click OK.

If “Use default” is selected, then Clearspan Communicator uses the default device set in the operating system preferences. For Windows, if “Default Communication Device” is defined, it is selected over the “Default Device”.

If you are using headsets, you can also select a separate device than the headset for alerting incoming calls.
4 CONTACTS

Contacts are the people with whom you communicate and, in most cases, you see their presence and share your presence with them. There are three types of contacts:

- **Contacts** – Actual people with whom you communicate.
- **Conferences** – Audio or video conference bridges that you use to communicate with others. Silent dialing into the bridge also applies to these contacts if enabled by your service provider.
- **Groups** – Containers of contacts and/or conferences.

4.1 ADD

When you sign in for the first time, there are no contacts on your contact list. Add a new contact at any time by selecting the Add Contact item from the menu or choose the Add (+) button from the main window.

In the Add Contact dialog box, enter the contact’s information and then click Add to Contact List checkmark. By default, your presence information is always shared with a new contact if an Extensible Messaging and Presence Protocol (XMPP) address is provided.

If you are accepting contacts via a buddy request, you may see the contact card after accepting the buddy request, depending on the service provider settings.

However, you can always share your presence information later by selecting Subscribe on the menu for that contact on the contact list (right-click the contact or arrow button). Note that the contact must accept your subscription request for you to establish the presence relationship successfully.

The newly added contact appears on your contact list.

Add a conference contact by clicking the same button you did for Add Contact and choosing the Add Conference Contact menu option. A conference contact is a special contact used for conference bridges to avoid remembering PIN codes and conference number, for example, recurring conferences. Just create a contact for the weekly conference, add a conference bridge number and PIN, and join the conference just by right-clicking the contact or choosing it and clicking the Call button.

Choose the Add Group menu option to add a new group to the contact list.

4.2 EDIT

Edit a contact by selecting the contact first. After you select the contact, right-click anywhere in the area of the selected contact and a menu of options appears. This base principle is the same for normal contacts, conference contacts, and groups. Note that depending on your service provider settings, all or no contact card fields may be editable. Depending on your service provider settings, you may also see a button for synchronizing the contact card with the Telephony directory or the synchronization may take place automatically. When the
manual synchronization button (cloud icon) is visible, there is no automated syncing of the contact card details with server information. To synchronize the contact card data, click on the cloud icon.

- **Unsubscribe** removes the presence relationship between you and that contact. This means you do not see the contact’s presence information and your contact does not see yours. To re-establish the presence relationship, select *Subscribe*. An unsubscribed contact remains on the contact list and is always shown without an icon. Any contact that is not presence-enabled is shown in the same way.

- **Remove** removes the contact from your contact list.

- **View Profile** opens the *Contact Information* dialog box where you can add, edit, or remove information. This works for both normal and conference contacts.

- For groups, choose the *Edit* menu option to rename a group.

### 4.3 FILTERS

You can filter contacts in two ways:

- Use the *filter* field to search by contact name. The contact list is filtered in real time as you type.

- Alternatively, use the filter menus available by right-clicking the *Contacts* icon in the left pane to display only specific types of contacts such as favorites or online contacts. You can also sort contacts based on first or last name or choose whether to display the contact’s avatar and availability status in the contact list.
5 PRESENCE

Instant Messaging (IM) and Presence (P) are optional Clearspan features.

For each contact you have subscribed to, you can see their presence. Similarly, your contacts can see your presence on their contact list.

Presence means that your friends are able to see whether you are available to communicate, for example, “I’m busy” or “I’m available”.

<table>
<thead>
<tr>
<th>ICON</th>
<th>WHAT IT MEANS</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟢</td>
<td>The green presence icon indicates that the user is online and ready for communication.</td>
</tr>
<tr>
<td>🟠</td>
<td>The yellow presence icon indicates that the user is online but has been idle or away from their computer for more than ten minutes.</td>
</tr>
<tr>
<td>🔴</td>
<td>The red presence icon indicates that the user is busy and does not want to be disturbed.</td>
</tr>
<tr>
<td>🔄</td>
<td>The grey presence icon indicates that the user is offline and the only available contact method is calling or chatting.</td>
</tr>
<tr>
<td>🟡</td>
<td>The question mark indicates that a subscription is pending and the contact has not yet approved sharing their presence.</td>
</tr>
<tr>
<td>☀</td>
<td>This icon indicates that the contact is busy due to a call. This is an automated presence status.</td>
</tr>
<tr>
<td>🗺️</td>
<td>This icon indicates that the contact is busy due to a meeting. This is an automated presence status. The Busy – In Call status overrides the Busy – In Meeting status so this one is only seen if there is a meeting but no call.</td>
</tr>
<tr>
<td>📱</td>
<td>This icon indicates that the contact is only available on mobile Clearspan Communicator.</td>
</tr>
<tr>
<td>📱</td>
<td>This icon indicates that the contact is only available on a compatible desktop phone, not Clearspan Communicator.</td>
</tr>
</tbody>
</table>

The avatar in this version is not completely in real time. The avatars are retrieved at login, when the contact is added, and when the contact comes online.

Double-click the avatar to change it. A File Explorer view opens.

If you see an error message at the top of the Main window “XMPP Unavailable”, it means that the XMPP connectivity has been lost for chat and presence; however, you can still make calls. You should contact your service provider.

Have the Outlook calendar automatically change your presence to Busy – In Meeting by enabling this in the Preferences → General tab.
The presence update is only triggered by appointments and meetings that are either accepted by the user or made by them. All day meetings do not trigger a presence change to *Busy – In Meeting*.

The XMPP address of a contact cannot be changed. Instead, you must delete the old address and create a new one.

Location in presence is done based on the IP address that the machine is using. The IP address is mapped to a physical location. If the system administrator has made it configurable, you can configure location information by clicking your Presence indicator and then clicking on your location.
6  CHAT

6.1  CHAT VIEW

Instant Messaging (IM) and Presence (P) are optional Clearspan features.

When you initiate a chat, the Chat window opens. Chatting with a contact is possible only when you are both online. If your contact initiates a chat, you see a pop-up notification in the bottom right-hand corner of the screen. If you close the Chat window and open it again, sent chat messages are shown in the window as chat history.

When the chat opens, you see the contact’s information at the top of the screen. If you want to use the whole area for writing, you can press the background of the information or the top bar. You can contract or expand the information of the contact during the chat and you can leave it open or closed depending on your preference.

At the top of the message area, there are four links: Yesterday, Last week, Last month, and All history. From these links, you can load history from your local storage and different time frames. You can delete the history using the drop-down menu.

In the text field, you can add a smiley emoticon. Smiley emoticons can also be added by manually entering the corresponding characters that represent that particular emoticon. You can send text by pressing ENTER.

To enter a line break in the text field, you can use the following key commands:

- CTRL+ENTER (COMMAND+ENTER on Mac)
- SHIFT+ENTER
- ALT+ENTER

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection for a menu to copy or paste the text to or from the Chat window.

It is also possible to chat with users in other domains. AastraConnect also supports Google federation. Group chat is not supported in Google federation, so the group chat option with these contacts is shown in gray.

6.2  FILE TRANSFER

File transfer functionality is accessible only through the Chat window.

1. To open the File Selection dialog box, click the Send File button on top of the text field.
2. Select the file to be sent from the dialog, and then click Open. You can also drag and drop a file into the Chat window.
3. Once the file offer is issued and during its transfer, you can cancel the transfer (at any time) by clicking Cancel.
4. Accept an incoming file transfer by clicking the **Accept** button.

5. Reject the file transfer offer by clicking the **Decline** button.

After the file transfer has completed, the received files can be opened or viewed in the file manager by using the *Click to open* and *Show in folder* links.

### 6.3 GROUP CHAT

Start a group chat by "multi-selecting" and right-clicking the main window contact list or through the Conference menu in the *Communications* window. More people can be added later to the chat by drag-and-drop or by using the Conference menu. Only the owner can add more participants.

A group chat works the same way as a one-to-one chat. All messages from anyone are sent to everyone else. All contacts need to be online to be able to participate in a group chat. You cannot invite an offline contact or a contact that is not on a device that supports group chat. This does not affect the group chat in any way.

A group chat history is saved and is available to view later in the *Messages* tab of the main window.

In the *text* field, the contacts’ names appear in different colors to easily distinguish between who is writing.

Only the newest chat room messages are stored on the server. One-to-one chat messages are only saved locally.

Deleting a chat room is not supported.

Chat rooms can be moderated by the owner. Use the right-click menu options to remove a participant from your chat room. If needed, the removed participant can join later. The removal also applies to desktop share sessions.

### 6.4 CHAT RECORDING

Chats can also be recorded as a service provider option; in this case, the client shows a recording indicator. Note that there are no end-user controls for chat recording.
7 AUDIO AND VIDEO CALLS

The following table describes additional Communications window icons and explains what you can do with them, for voice and video calls.

<table>
<thead>
<tr>
<th>ICON</th>
<th>WHAT YOU CAN DO</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enter additional digits using the dial pad at any time during the call (for example, to insert a conference number). The dial pad is movable and can be dragged around the Video Call screen to a location you set.</td>
</tr>
<tr>
<td></td>
<td>Mute your microphone by clicking the mute icon.</td>
</tr>
<tr>
<td></td>
<td>Adjust the volume bar to adjust the volume. Dragging it all the way to the left mutes your speakers. This is shown by a small slash in front of the speaker icon.</td>
</tr>
<tr>
<td></td>
<td>Use this icon to access the Call Options menu. In the Call Options menu, you can find different actions to use for a call depending on your settings and your service provider.</td>
</tr>
</tbody>
</table>

In the Options menu, there are the following options:

- Transfer a call to a third party.
- Put the call on hold. Note that if you hold the call, the other party cannot "un-hold". This freezes a video call to the last frame of the video feed. In both voice and video calls, this is communicated to all parties by a notification appearing in the middle of the screen.
- Hide your own video.
- Add participants to the call.

Dial a number in the combined Search and Dial field to make a call. Once you type your numbers, Clearspan Communicator searches for contacts on both the local contact list and the enterprise directory.

You can also call circuit-switched network numbers such as Global System for Mobile Communications (GSM); however, this depends on the service provider network you are using; there is no technical limitation.

Choose your video size from the Preferences and the Video tab. Your selection is used by default for future video calls. The available sizes are automatically presented based on your camera. The selected video size can be modified automatically depending on your CPU load and changing network conditions to optimize the video quality.
7.1 CALL FROM YOUR COMPUTER

Select a contact from your contact list to start communication and click the desired communication button. Type a phone number in the Search and Dial field at the top of Clearspan Communicator window (search or communicate), to communicate with someone who is not on your contact list.

7.2 CALL FROM PHONE

The second option to communicate in the row of communication buttons is the Call from Phone. When you click this button, the desk phone instantly starts ringing and the call is established from your desk phone. This depends on your service provider configuration as other devices may also ring.

For remote calls initiated using the Clearspan Communicator, you can also have mid-call controls such as hold/resume, transfer, and add participant.

Automatic Busy – In Call presence also works with the Call from Phone feature.

7.3 ANSWER CALL

When someone is calling you, you see a pop-up notification on your screen. You can choose to answer, silence the incoming call, and then open a chat session with the caller, reject the call, or silence the incoming call by closing the popup notification window. If you silence the call, the ringtone is silenced but the caller does not see anything on their end. You can answer or reject the call after silencing it only if you have chosen the chat option. If you close the incoming call pop-up notification to silence an incoming call, then you do not have an option to answer or reject it any more. When choosing the chat option, chat is only enabled after the call has been answered or rejected.

If you reject the call, it causes the line to sound busy at the caller’s end and they know that you rejected the call.

When someone is calling you with a video, you see the same pop-up notification; however, the options are answer with video, answer as voice only, silence and chat, reject, or silence (by closing the popup window). If you decide to answer as voice only, the call is voice only.

7.4 CONTACT NAME LOOKUP FOR INCOMING CALLS

Whenever the incoming call does not have a calling name associated with it, Clearspan Communicator can perform a local contact search. If the number matches one of the contacts on the Clearspan Communicator contact list, the name is shown on the incoming call screen along with the alert.

Whenever you retrieve your call logs/history and the call log does not have a calling name associated with it, Clearspan Communicator does a lookup in the local contacts and populates the name if a match is found.
7.5 MISSED CALL OR COMMUNICATION

When you have one or more missed calls or other types of communications, there is a notification on the left-hand side of the navigation pane in the main window. Clicking the icon takes you to the missed communication in the Communications History view.

7.6 FULL SCREEN IN VIDEO CALL

Full screen mode can be activated by clicking the Full Screen button or by double-clicking anywhere on a video.

Exiting full screen mode is done by pressing the ESC key or the Windows button. Exiting full screen makes the video call go back to its original state (even if there was resizing of the window previously before going full screen).

In a full-size window, you can see a similar Options menu at the top. It has the same functionality as it does in the normal view. When you move the mouse, the top bar and lower communication buttons appear on top of the video.

7.7 MULTIPARTY SESSIONS

You can have many participants in a call, either in a My Room or in an ad hoc multiparty call. Add more participants by dragging and dropping them on to the Communications window or by selecting the Conference menu item via the Communications window menu button. By choosing the menu item, you can also add participants with just a telephone number.

In contrast to using My Room, which uses your permanent chat and collaboration rooms and conference bridge, you can start ad hoc multiparty sessions by either selecting multiple contacts on the contact list and starting a chat, by calling with them, or by expanding a one-to-one session into a multiparty session by dragging and dropping a contact into the Communications window. In an ad hoc session, the room used is a temporary one that is deleted once the session ends (that is, when the last participant leaves). Voice conferencing does not use a bridge but instead uses the Clearspan N-Way Calling supplementary service in a sequential fashion.

If the XMPP service is not available, then ad hoc multi-party calls are not available.

7.8 CALL WAITING

You can have one active call at any one time if you receive a new incoming call and accept it. The existing call is put on hold and you can change between these two calls by using the Hold and Unhold buttons.
7.9 CALL TRANSFER

Blind call transfer is available in the Communications window; choose the Transfer Call menu item to transfer the call to someone else. Attended call transfer is also available in the same window, first call someone to check if the called party can take the incoming call and then transfer the incoming call to the desired called party.

7.10 MESSAGE WAITING INDICATION AND VOICE MAIL

The Message Waiting Indication (MWI) service allows you to receive a notification for a waiting voice mail or video mail. By clicking on the message icon in the upper right-hand corner of the main window, Clearspan Communicator calls the predefined mailbox number to allow the user to listen to the voice mail or view the video mail.

It is also possible to call voice mail from the dialer by long pressing the "1" icon in the dialer.

Missed calls are indicated by an icon in the main window. Missed video and audio calls are indicated with a different icon. Note that the MWI icon is in the same place when it indicates a new voice mail.

7.11 CALL PARK AND RETRIEVE

Call Park is particularly suited for shared environments where one person can answer the call, park it, do something else for a while and continue the call from another device or let somebody else continue the call.

Transfer an ongoing VoIP call to a Call Park server and then retrieve it when needed. An ongoing call can be parked against your own number or another number (an extension). Call Retrieval works in the same way, the parked call can be retrieved from your own number (an extension) or another number (an extension) to provide flexibility for who is picking up the parked call.

A parked call is visible on your desktop in the active communications area so that you can easily retrieve it, but only for the duration of the Clearspan Call Park announcement. After the announcement is over, the parked call disappears from the active communications area (since the triggering call is disconnected). After the call disappears from the active communications, the user has to remember the extension to which the call has been parked to retrieve it using the main window menu (or feature access code), unless the call was parked to the one's "own" extension. If the call is not retrieved after a certain time, then the server calls the parking user.

7.12 CALL PULL

Call Pull allows you to pull an ongoing call from one of your devices to another one where the Call Pull feature is used. Call Pull can also be used with feature access codes (FAC), in this case, *11. In this release, user interface support has been added to the desktop so that an end user does not have to remember feature access codes.
7.13 CALL RECORDING CONTROLS

You can use call-recording controls in this release. Depending on your service provider’s configuration, call recording can be initiated when a call starts or dynamically during a call (and start, stop, pause controls may be available). Additionally, there is an audio indication that call recording is ongoing as well as a visual indication. Feature access codes can also be used to control call recording when enabled in the configuration.

Recorded calls are accessed outside of Clearspan Communicator; you cannot view them using the client.

Depending on your service settings, Call recording behavior is one of the following (this cannot be controlled in the client but in the self provisioning portal):

- Always – recording indication (icon) in the Communications window as well as the Active Communications UI.
- Always with pause/resume – recording indication (icon) in the Communications window as well as in the Active Communications UI (only pause/resume menus available).
- On demand – recording indication (icon) in the Communications window as well as the Active Communications UI (no stop menu available, only start and pause/resume). After a call is established, call recording starts on the server. If the user presses the Start Recording button during the call, the call recording is stored and the server keeps the recording of the whole call regardless of when the recording was started (except for pauses). Otherwise, if no start recording is initiated from the user, the call recording is deleted from the server.
- On demand with user-initiated start – recording indication (icon) in the Communications window as well as the Active Communications UI (menu options available for start, stop, and pause). Call recording can be initiated at any time and several times during a call. There are separate call recordings for each call recording startup.
- Never – no indicators or menu options present.

Pause/resume audio indication depends on your service provider settings. It is recommended to re-login after changing the call recording mode in the self provisioning portal.

7.14 MEET-ME MODERATOR CONTROLS

You can control the functionality available to Meet-Me participants if you are the owner of the session in My Room. You can do the following:

- Dismiss one or more participants.
- Mute one or more participants.
- Lock or unlock the room (when locked no more participants can join).
- See active talker indication.
- See full audio participant list.
To invoke the features, you can use either the right-click menus or you can click on the Meet-Me moderator control icons of a participant. Note that most features are not available via icons. To dismiss or mute all participants or lock the room, use the right-click menus available for your own icon at the top of the participant list.

If you are not the owner, you can only see the XMPP (chat) participant list.

7.15 FORCED LOGOUT

Depending on your service provider settings, you may see a popup saying that you have been logged out due to another instance of the client logging in. This feature allows Clearsnp to track similar online client instances and only allow one of them to be online at the same time. When Clearsnp notifies the client to log out, all connections are terminated and client returns to the login window.

7.16 ECHO (TEST) SERVICE

Use this Main window menu option to make a test call to verify voice and video quality. The echo service asks you to record a message and plays that message back immediately before hanging up. The echo service may be available in different languages depending on your service provider settings.

7.17 HEADSET SUPPORT

You can control incoming and ongoing calls from a compatible headset. The feature set supported is answer/hang up as well as mute/unmute and volume up/down. The following Plantronics headsets have been tested, although other Plantronics devices should also work:

- Voyager Pro UC
- Savi 700 series
- Blackwire C3xx, C4xx, C5xx, and C7xx
- Calisto 620
- Audio 628USB
8 DESKTOP SHARE

To share your desktop:

1. In the main window, select a contact and click the Share Desktop button.

2. In the Communications window, click the Share Desktop button. This does not yet start the "share" but instead sets up connections to the server.

   Once the server connection is set up, a Play button appears to start actually sharing your desktop.

3. To stop sharing, click the Stop icon. You are prompted to confirm the stopping of the "share". While sharing, all other communications mechanisms are also available, except for video calling and file transfer.

4. To hide or unhide the Chat view, click the Chat button in the Communications window.

Desktop sharing works the same way in both My Room and the ad hoc sessions. For participants without Clearspan Communicator, use the separate Desktop Share Invitation link available by right-clicking the My Room button.

If you are using dual monitors, the client should share the primary monitor. If you have been sharing different monitors, make sure that you want to share the primary monitor. You can check the primary monitor in the operating system settings.

You can also remove desktop share participants. They are also removed from the group chat at the same time. If needed, the removed participants can join later.

Depending on your service provider settings, you may have to provide desktop share credentials manually.

My Room and Desktop Sharing are optional Clearspan features.
9 MY ROOM

My Room is started by clicking on the My Room icon on the left-hand side of the navigation pane. My Room is started automatically using your permanent chat room. Add more participants by dragging and dropping them into the Communications window or the Conference menu, or they can join your room by right-clicking your name on their contact list and choosing the Join room menu option. Once people have joined the chat room, they can click on the Call button of that window to join the conference. The room owner can also share their desktop.

To use the full functionality of My Room (desktop sharing, conferencing, and chat combined), you must manually enter your desktop sharing credentials, your conferencing number, and your PIN in the Preferences → Credentials window.

Only the owner of the room can share the desktop or add more participants. This applies to both My Room and any ad hoc sessions.

1. To see a Context menu, right-click the My Room icon on the left-hand side of the navigation pane.

2. To modify credentials and conference bridge information, select Configure to go to the preferences. If your service provider has automatic provisioning enabled, then this menu item is not present.

3. Select Copy invitation to copy an invitation link to the operating system clipboard (depending on your service provider setup, this menu option may not be available). Paste this link, for instance, to meeting invitation e-mails to allow Clearspan Communicator participants to join the conference in one click from, for example, Outlook or Office applications. You can also copy the My Room invitation to the default email client and go to the My Room preferences via a right-click menu option.

The link has two parts, one for Clearspan Communicator users, and another one for users with some other client. Depending on your service provider settings, the invitation can also contain a link to the desktop sharing session. The invitation always contains a dial-in number and PIN for users who do not have Clearspan Communicator. The desktop share link, when available, allows anyone to join a desktop share session from a standard web browser. In addition, the Clearspan Communicator group chat session is supported with the web collaboration session.

The My Room icon also has a tooltip indicating the conference bridge details of your My Room.

Desktop sharing works the same way for both My Room and the ad hoc sessions.

My Room uses your permanent chat room, permanent collaboration room, and conference bridge (audio or video). My Room is the only way to use the permanent rooms. Any other multiparty communications, such as selecting multiple contacts, and right-clicking for a conference call, or dragging and dropping for a one-to-one chat, is done using ad hoc rooms. Ad hoc rooms are deleted once the session is over.
All My Room sessions start as chats but call and/or share can be added to the session while in progress. File transfer and video conferencing are not supported in My Room or ad hoc sessions.

My Room and Desktop Sharing are optional Clearspan features.
10 SEARCH

Clearspan Communicator supports a search of the enterprise directory. This takes place in the same search field that is used for both a local and presence-enabled contact list search.

Clearspan Communicator automatically searches the local contacts and presence-enabled contact list in addition to the enterprise directory at the same time. As soon as there are results from the enterprise directory, these results are shown on a separate list in the main window. Additionally, there may be other search result groups from other search sources such as Lightweight Directory Access Protocol (LDAP) or Outlook.

Search results are displayed differently depending on the results of the contact list and directory search:

- If LDAP search (Corporate directory) or Outlook search are enabled, there are more result groups.
- If there are no results for a certain search source (local contacts, Outlook, LDAP, or Clearspan telephony directory) that group is different in the user interface (UI).

The enterprise directory searches all available fields for the search string. By default, it waits for 1.5 seconds before it sends the search request to the server to minimize unnecessary load on the server.

Typically when adding a contact using directory search results, there are phone numbers and first names in addition to last names available. In addition, the Extensible Messaging and Presence Protocol (XMPP) address and other fields are imported when found to allow presence and chat.

LDAP search (Corporate directory) needs to be enabled by your service provider. In addition, you need to manually provide your LDAP credentials in the Preferences → Security tab. LDAP search results are provided in the corporate directory group in the search results.

Outlook integration (search and calendar integration) on Windows requires one of the following versions installed on the desktop:

- Outlook 2007
- Outlook 2010
- Outlook 2013

Outlook search also works when several Outlook accounts are in use, but only one account is used at a time (default selected, which can be changed in Outlook). Additionally, other related considerations are as follows:

- The client searches for contacts and calendar entries in the default Outlook account. The account is set to the default via File → Info (left pane) → Account Settings → Account Settings → Data Files. Select an account and mark it as “Set as Default”. After making this change, sign out and sign back in to the client and it now searches that account for contacts and calendar entries.
The client searches the Outlook contacts only on the local machine (that is, the Outlook Address Book). There is no Exchange server lookup performed. In addition, all directories in Outlook are searched for contacts, even deleted folders. The Contacts directory can also have multiple levels of subfolders.

Every minute, Clearspan Communicator reads Outlook appointments. If there is an appointment running at the current time, then the presence is shown as *Busy – In Meeting*. Overlapping appointments are also handled. Following are some examples of Clearspan Communicator operation with Outlook when time is 9:10 A.M.

- There is meeting "A" 9 A.M. through 10 A.M. Presence is shown as *Busy – In Meeting*.
- Presence is explicitly changed to *Available* at 9:15 A.M. Presence is shown as *Available*.
- In the next minute, Clearspan Communicator again reads the appointments and sees that “A” meeting is running; however, the presence was already explicitly marked as *Available* and presence is not shown as *Busy – In Meeting* but *Available*.
- There is an overlapping meeting "B" 9:30 A.M. through 10:30 A.M. Presence is shown as *Busy – In Meeting* when the time is 9:30 A.M.

When deleting a meeting that is currently ongoing in Outlook, the presence status remains as *Busy – In Meeting* until the next time Outlook appointments are checked (once every minute) and after that, presence is shown as *Available*. This change may be instantaneous or it may take a minute depending on how close the timer is to being triggered.

The Outlook Object Security model was introduced in Outlook 2007. It has been tested with Outlook 2010 and Outlook 2007. For Outlook versions prior to 2007, the Allow/Deny pop-up window seen in previous releases should not be triggered. However, those versions are not officially supported. For Outlook 2013, the behavior should be similar to 2007 and 2010, meaning the popup should not come up with Outlook 2007, 2010, and 2013 in Release 20.0.0 and onwards. However, more tests are needed for this before official support for Outlook 2013 can be declared.

The presence update is only triggered by appointments and meetings that are either accepted by the user or made by them. All-day meetings do not trigger a presence change to *Busy – In Meeting*. 
11 FULL ENTERPRISE DIRECTORY

Clearspan Communicator allows for the browsing of an entire Clearspan enterprise directory.

To view the Clearspan enterprise directory, click the Directory button on the left-hand side of the navigation pane (if available). This feature depends on the service provider configuration so it may not be visible in all clients.
12 COMMUNICATIONS HISTORY

The fourth icon from the top in the main window on the left side of the navigation pane displays your messaging history. Double-clicking a conversation on the list opens it in a new window.

Clearspan Communicator saves a call history for placed, received, and missed calls. The call history makes it easy for you to redial and call back when you have missed a call or you want to easily dial a contact with whom you have recently spoken.

Double-click on a name in the list to call back directly (this calls back the same way you previously spoke, for example, if you were in a video call, double-clicking starts a new video call). Double-clicking an incoming call item from presence-enabled contacts opens a chat window, from which a call can also be made.

To clear the missed chat indicator, you need to open the missed chat.

The Communication History missed communications badges can be cleared by using the right-click menu from the Communication History button on left-pane. The menu provides options to clear “All missed”, “Clear missed chats”, and “Clear missed calls”.


13 PREFERENCES

Preferences provide access to available settings for Clearspan Communicator. Follow these steps to access Preferences.

Windows
1. Click the Clearspan Communicator logo in the main window title bar.
2. Select Preferences.

OS X
1. Select Clearspan Communicator from the main menu.
2. Select Preferences.

13.1 CREDENTIALS

My Room
Specify the conference details to be used for your My Room. If your service provider has automatic provisioning enabled, then you cannot change these details.

Web Collaboration
Depending on your service provider settings, web collaboration credentials may need to be manually entered and can be viewed and edited. If automatic provisioning is enabled, then you cannot change these details.

Protocols
If protocols such as XMPP or Xsi are available to be viewed, they appear here.

Device Management
If the Device Management configuration URL is available to be viewed, it appears here.

13.2 GENERAL

Language
Select your language and then click OK or Apply and the change takes effect immediately. Note that the number of languages depends on your service provider.

Log In
Enable or disable automatic sign-in when starting the application.
Confirmations

Usually there is a confirmation pop-up notification each time you remove a contact or call history record. By selecting one or all of the check boxes, you disable the confirmations when deleting information. Here you can also control whether there always is a pop-up notification for publishing location information. Typically, this is shown at login.

Depending on your service provider configuration, you can also have confirmations for Clearspan Communicator API, which is used by third-party applications such as Outlook Add-in or compatible headsets. You can allow such third-party applications in Preferences to obtain information from Clearspan Communicator and enable or disable confirmation pop-up notifications when third-party applications request information from Clearspan Communicator. You can also choose default behavior to always reject or accept requests from third-party applications and allow or reject individual third-party applications.

Logging

Logging is used for troubleshooting. You may be asked by your service provider to turn on logging and then send a log file directory.

13.3 AUDIO

Output Device (Speakers)

Choose a headset, PC-integrated speakers, or external speakers for audio output. Your external playback device is selected by default (if you have one connected).

Voice Recording (Microphone)

Choose a headset microphone, PC-integrated microphone, or external microphone for voice during calls. Your external recording device is selected by default (if you have one connected). You can also choose automatic gain control and test your recording device.

Alert Signal

Select the audio device and ring signal that is played when you receive an incoming call. The same signal is used for both voice and video calls. You can also select your own ring signal.

Sounds

Select which events cause a notification sound. To disable the sound, uncheck the check box. Select a sound event and then click Play to hear the sound.

13.4 VIDEO

Capture Device

Select a camera that you want to use for video calls. Your external web cam is selected by default (if you have one connected).
Video Size

Select one of the available sizes. Note, however, that higher sizes require more bandwidth and a more capable central processing unit (CPU).

13.5 PROXY

Proxy Settings

Select how to handle HTTP proxies. By default, the system settings are used but you can also choose not to use an HTTP proxy or to use Clearspan Communicator (client) proxy settings.
14 CALL SETTINGS

Clearspan Communicator supports the following service management features allowing supplementary services to be managed using the native Clearspan Communicator Call Settings window:

- Clearspan Anywhere
- Clearspan Remote Office
- Call Forwarding
- Do Not Disturb
- Hide Number (Calling Line Identification Presentation [CLIP]/Calling Line Identification Restriction [CLIR])
- Simultaneous Ring Personal

You can also use the call settings with a Main Window toolbar on the top of the window, if this feature is enabled. When enabled, this feature allows Clearspan Anywhere, Do Not Disturb, Remote Office, and Call Forwarding to be managed in the Main Window using single clicks or right clicks.

14.1 CLEARSPAN ANYWHERE

Clearspan Anywhere allows service providers to offer fixed-mobile convergence (FMC) services today without additional equipment.

Clearspan Anywhere simplifies communications for on-the-go users and remote users by extending the features of a desk phone to any other fixed or mobile device, regardless of the network or handset manufacturer. Callers dial one number and can reach you on any phone the user chooses. A desk phone, cell phone, and/or a soft phone may ring simultaneously.

Enjoy voice call continuity with the ability to move live calls from one device to another without hanging up.

Add locations (numbers) that can be used in the service via the Add New Location button. Use the Alert all locations simultaneously check box to activate parallel ringing.

The Diversion inhibitor check box prevents a call ending up as a voice mail, which can be problematic in, for example, conference call situations.

Select Answer Confirmation to receive a separate audio prompt when answering a call from that number (location). It may be useful in cases where, for example, mobile numbers are being used to prevent incoming calls going to mobile voice mail since the call will be ended without going to voice mail if the answer confirmation is not provided.

Select the Call Control check box to enable the server platform to provide mid-call services such as Call Transfer and Conferencing for that number (location).

Clearspan Anywhere is a premium feature.
14.2 CLEARSPAN REMOTE OFFICE

This service allows the use of any phone as the office phone from a charging and numbering perspective. For instance, a hotel room phone can be used as the office phone.

Enable Remote Office by clicking the Edit icon and specifying a phone number to be used as the Remote Office number.

Clearspan Remote Office is a premium feature.

14.3 FORWARD CALLS

Enter a number to which your calls should be forwarded. Different variants of call forwarding are supported, such as forwarding always, forwarding when busy, and forwarding when you cannot answer or when you are unreachable.

14.4 DO NOT DISTURB

When you activate this service, all calls are typically blocked by the server and sent to voice mail. Enable this service by clicking the Enable check box.

14.5 HIDE NUMBER

You can hide or display your number when calling or communicating with other parties or contacts. Hide your number by clicking the Enable check box. To show your number, set this to Disable.

14.6 SIMULTANEOUS RING PERSONAL

Add up to ten additional numbers or Session Initiation Protocol Uniform Resource Identifier (SIP-URI) addresses that you would like to ring in addition to your primary number when you receive a call. In addition, specify whether you want answer confirmations. This service is an older variant of Clearspan Anywhere.
15 SIGN OUT

Signing out of Clearspan Communicator sets your status to “Offline” for your contacts and displays the Sign In screen.

15.1 SIGN OUT OF CLEARSPAN COMMUNICATOR

To sign out, follow these steps.

Windows
1. Click the Clearspan Communicator logo in the main window title bar.
2. Select Sign Out.

OS X
1. Select Actions from the main menu.
2. Select Sign Out.

15.2 EXIT APPLICATION

To exit the application completely, follow these steps.

Windows and OS X

Close the Sign In window.

Windows
1. Select the Clearspan Communicator logo in the main window title bar.
2. Click Exit.

OS X
1. Select Clearspan Communicator from the main menu.
2. Select Quit Clearspan Communicator.

Note: Closing the main window (not the Sign In window) does not exit the application but rather minimizes the application to the system tray (Dock). This allows you to continue to receive calls and messages without having the Contact List window appearing on the desktop.
16 MULTI-DEVICE SUPPORT

Clearspan Communicator supports users with multiple devices, according to the XMPP specifications. This is comprised of several features:

- Chat invitations sent to a user are received in all devices. Before the session is accepted, messages are sent to all devices and once answered, the chat messages go to the device that has sent a reply message.

- One can retrieve one’s own presence notifications when another client updates the user’s presence. The client stores this information and updates its own presence so that it is the same as the higher priority status it received, (that is, when the received status update is manual). If the received presence update is not manual, it does not react to the received update; it only notes it.

- Accepting a sharing presence invitation in one client is also recognized by another client, and both clients start receiving presence updates.

- A new presence subscription made in one client is recognized in another. If the contact blocks the “invitation”, there are presence notifications from the server to all of the user’s clients that indicate that the subscription was terminated and this information is shown to the user. If the client receives two presence authorization requests from two or more devices for the same user, it only shows one request to the user.

- Removing a contact from the contact list in one device is recognized in another client and the contact list is updated (that is, the contact is removed) in the other client as well.

If a user has many devices, each device has the same status when shown to the end user. In addition, the contacts on the contact list always see the same status with updates shown in the following priority order:

- Busy
- Online
- Away
- Offline

This means, for example, that if one client publishes a Busy status and another client publishes another status, contacts see the user as Busy. Compatible devices such as desk phones are able to show presence in the same way.
17 SYSTEM REQUIREMENTS

System requirements are as follows:

- Operating system: Mac OS 10.6 Snow Leopard, Mac OS 10.7 Lion, Mac OS 10.8 Mountain Lion, Mac OS 10.9 Mavericks, Windows Vista, Windows 7, or Windows 8 (Classical view only).
- The installation footprint is approximately 125 megabytes (MB).
- For voice calls, a sound card, speakers, and a microphone or a headset are required.
- For video calls, a web cam is required.
- A minimum 1 GB random access memory (RAM) is required.
- Minimum 1 gigahertz (GHz); however, 1.5 GHz is recommended, Pentium 4 at a minimum, dual core CPU is recommended for video calls at a minimum.
- Open Graphics Library (OpenGL) 1.5 or higher is recommended.
- For high-definition (HD) video, the following is recommended:
  - HD camera
  - HD resolution support in display
  - Pentium Quad Core or equivalent
  - 2 GB RAM
18 TROUBLESHOOTING

Why can’t I chat with contacts from Yahoo?

Chatting with users in other domains is possible, but depends on the domain. For instance, AastraConnect supports Google federation but not Yahoo. However, group chat is not supported in Google federation, so the group chat option with those contacts is shown in gray.

Why can’t I change the avatar?

Double-clicking the avatar should open a File Explorer view to select a file. If your XMPP connection is lost, changing the avatar does not succeed. A lost XMPP connection is indicated in the main window’s top notification area.

My contacts are all offline and my client’s status bar says “XMPP unavailable”. What does this mean?

It means that the XMPP connectivity has been lost for chat, as well as for presence; however, you can still make calls. You should contact your service provider.

Why am I offline?

If you have selected “Offline” status, you are shown as offline to others. Another possibility is that you may have lost your Internet connection. In this case, the client does not log out, but rather enters an offline mode where a contact list is available but communication is not possible.

Why can’t I have more video resolutions available?

You can choose your video resolution from Preferences and the Video tab. Your selection is used by default for future video calls. The available resolutions are automatically presented based on your camera.

Why can’t I change my user name and password?

User name and password editing is not supported in the client. To edit your user name or password, contact your service provider.

In the preferences, the client only supports changing LDAP and desktop sharing credentials.

Why does my all day calendar entry not trigger Busy – In Meeting presence status?

All day meetings do not trigger a presence change to Busy – In Meeting.

To trigger the presence update, the meeting must be self-generated or accepted (tentative or fully accepted). The presence update is only triggered by appointments and meetings that are either accepted by the user or made by them.
Why aren't all my group chat messages saved?

Only the newest chat room messages are stored on the server, but never for My Room.

Why aren't all my chat messages available in my other devices?

All 1-1 chat messages are saved, but only locally, so they are not necessarily available in your other devices. Incoming messages are sent to all devices; however, the ones that you send are only stored in the device that you are using to send the message.

Why can't I change the XMPP address of a contact?

This is not supported in this release.

Why does my location show an incorrect address?

It is done based on the public IP address that the machine is using. The IP address is mapped to a physical location. BroadSoft is working with the mapping provider to improve the accuracy of the location. You can also manually change the location by clicking the avatar and changing the location icon, if your system administrator has made it configurable.

Why can't I start desktop sharing?

To share your desktop, you need to have valid credentials, either by manually entering desktop sharing credentials in the Preferences → Credentials window, or by using auto-provisioning to enable the desktop sharing menu items and icons. However, you can participate in desktop sharing sessions even without any sharing credentials. Your service provider settings dictate if auto-provisioning is enabled or not.

Why can't My Room participants share the desktop?

Only the owner of the room can share the desktop. This applies to both My Room and ad hoc sessions.

I have a Plantronics USB headset and the call control features are not working. Is there anything special I need to do to enable call control support?

In order to use Plantronics headsets on Windows (not supported on OS X), several steps are needed:

1. When the client is started, you must accept the API connection request from the connector/add-in device.

2. In addition, you must separately install the Plantronics Spokes framework for USB phones to work if it is not already installed. Instructions for Spokes installation should be part of the USB headset installation packages. The Spokes software itself can be downloaded separately from the Plantronics web site.

Additionally, your client must have the feature enabled by your service provider.
# APPENDIX A: KEYBOARD SHORTCUTS FOR DESKTOP

The following table lists the currently supported keyboard shortcuts. You can use these keyboard shortcuts to quickly perform frequently used actions.

<table>
<thead>
<tr>
<th>SHORTCUTS FOR WINDOWS</th>
<th>SHORTCUTS FOR MAC</th>
<th>WHAT IT DOES</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Cmd-Q</td>
<td>This quits the application.</td>
</tr>
<tr>
<td>CTRL+F4</td>
<td>Cmd-W</td>
<td>This closes the selected window (except for a contact card and the About windows).</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Cmd-C</td>
<td>This copies selected text from Clearspan Communicator to the clipboard.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Cmd-V</td>
<td>This pastes text from the clipboard to the location selected using the cursor in Clearspan Communicator.</td>
</tr>
<tr>
<td>Enter</td>
<td>Enter</td>
<td>When in the Communications window, this sends a chat message (if the Chat view is visible). When in the contact list, this opens a chat with the selected contact. When in the Communications History, this opens a communications session with the contact or address related to the selected item. This opens a chat if the item was chat and a call if the item was a call.</td>
</tr>
<tr>
<td>-</td>
<td>Cmd-</td>
<td>This opens Preferences.</td>
</tr>
<tr>
<td>F1</td>
<td>Cmd-</td>
<td>This opens Help.</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Cmd-A</td>
<td>This selects all text in the Chat view.</td>
</tr>
</tbody>
</table>
APPENDIX B: USB HEADSET CONFIGURATION

This section describes the steps necessary to properly configure USB devices to function with Clearspan Communicator. These configuration steps currently apply to Plantronics headsets and Polycom U300 USB telephones running in the Windows platform only.

First, make sure that “Use Default” is selected in the Audio tab of Clearspan Communicator Preferences for both input and output devices.

![Preferences Window]

Figure 1 Preferences Window
Next, make sure that the Sound settings in Windows pertaining to “Recording” and “Playback” devices are correctly configured. From the Sound applet, select the Playback tab.

![Sound Window – Playback Tab](image)

**Figure 2** Sound Window – Playback Tab

In this example, the user has a Plantronics BT300M (the USB dongle accompanying a Voyager Legend UC) connected to their PC.
Click **Headset Earphone** to highlight the device and click on the drop-down arrow next to the **Set Default** button.

**Figure 3** Sound Window – Playback Tab – Set Default
Select *Default Communication Device*. The following screen is displayed.

![Sound Window – Playback Tab – Default Set](image)

*Figure 4 Sound Window – Playback Tab – Default Set*
Next, select the *Recording* tab.

![Sound Window – Recording Tab](image)

*Figure 5 Sound Window – Recording Tab*
Again, click on **Headset Microphone**, which represents the connected Plantronics BT300M device, and click on the drop-down arrow next to the **Set Default** button.

![Figure 6 Sound Window – Recording Tab – Set Default](image-url)
Select Default Communication Device.

![Sound Window – Recording Tab – Default Set](image)

**Figure 7 Sound Window – Recording Tab – Default Set**

Click **OK** to save the changes. The *Sound* window is dismissed and your device is now ready to be used by Clearspan Communicator.